ERDC/CHL CHETN-XIV-7
10 October 2003

	[image: image39.png]



	Coastal and Hydraulics Engineering Technical Note




US Army Corps

of Engineers

SBAS-A: SBAS for ArcView Application - Update

By Rose Dopsovic

GETTING STARTED:

SBAS-A has been designed exclusively for use in ESRI’s ArcMap© environment of ArcView 8©.   It is integrated directly into the ArcGIS© Desktop via a customized toolbar. This custom application is available for download from Coastal Hydraulics Lab’s website, http://chl.wes.army.mil or http://gis.sam.usace.army.mil.  

Installation Instructions: 

1. Download the SBAS-A setup file (setup.exe) from the Coastal Hydraulics Lab’s website.

2. Double-click on setup.exe and follow the on-screen instructions for installation of SBAS-A (version 1.2 into the ArcMap© environment.

3. Open the ArcMap© application.  The SBAS-A toolbar will appear as a floating toolbar in the display.  This toolbar can be mounted by dragging and dropping it on any existing toolbar.   If at any time after installation this toolbar is not visible, it can be activated by selecting the SBAS-A Toolbar option in the Toolbars item in the View menu.
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SBAS-A Toolbar
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Accessing the SBAS-A Toolbar.  If “SBAS-A Toolbar” is not visible in the list, the SBAS-A installation files have not been setup correctly.


Toolbar Description:
	Alternative Menu
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	New Alternative: Simply creates a new instance of an alternative

Load Project Alternative: This tool allows the user to Save and Load Alternative files (*.sbd).  Users MUST load the Alternative file that is associated with the Sediment Budget shapefiles before editing an existing Sediment Budget.

Save Alternative: Allows the user to select which alternative to save.  Any layer marked with the instance of the selected alternative, will have it’s attribute table updated with the name and path of the associated alternative file.

Save Project/Alternative: Prompts the user to save the ArcMap project (.mxd) and the appropriate Alternative file.

Set Preferences: Use this tool to set Working Directory, Projected Coordinate System, Measurement Units, Uncertainty Method, and default labeling options.

	Budget Menu
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	Load SBAS Layer: Allows the user to browse to a SBAS layer.  This tool will automatically load the associated Alternative file for this layer.  

Convert Graphics to New Layer: This tool allows the user to create a new Alternative and/or convert graphics in the display into Littoral Cells or Flux Arrows data layers.

Add Graphics to Existing Layer: Users can add additional cells or fluxes to existing Sediment Budget layers.  Using the selected graphic(s) in the display, this tool converts the graphic(s) into the selected layer.

Create Macro Budget: A macro budget can be created as a new layer, when a user draws a polygon (with Draw Rectangle or Draw Polygon tool) around a micro budget.  This tool automatically calculates a total residual for all cells residing in the macro budget polygon.

	Edit Menu
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	Remove Cells/Fluxes:  This tool will only be activated if an Edit Session has been started.  This tool deletes the selected feature of the active layer in the table of contents and removes the feature from the Alternative.

Remove Macro Budget: This tool releases cells from the Macro Budget.  If individual cell needs to be edited, it first must be removed from the Macro Budget.
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	Change Direction of Flux Arrow
	An Edit Session must be started to enable this tool.  This tool changes the direction of the selected flux arrow and updates the sediment budget with the new values.
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	Edit Cell or Flux Values
	Using the selected feature of the active layer in the table of contents, this tool provides an interface to enter cell and flux values.


Definition of Terms:

Alternative: An Alternative represents one set of assumed conditions for a particular sediment budget.  Each Alternative has its own set of fluxes, cells, placements, and removals.

Attribute Table: A table used to store attribute information for a specific coverage feature class. Each row represents a feature and each column denotes a field. To view a layer’s attribute table, right-click on the layer in the Table of Contents and select the “Open Attribute Table” option. 

Feature: A point, line, or polygon in a coverage, shapefile, or geodatabase feature class. 

Layer: A collection of similar geographic features—such as rivers, lakes, counties, or cities—in a particular area or place referenced together for display on a map. A layer references geographic data stored in a data source, such as a shapefile, and defines how to display it. You can create and manage layers as you would any other type of data in your database. 
Projected coordinate system: A reference system used to measure horizontal and vertical distances on a planimetric map. A coordinate system is usually defined by a map projection, a spheroid of reference, a datum, one or more standard parallels, a central meridian, and possible shifts in the x- and y-directions to locate x,y positions of point, line, and area features. 

A reference system consisting of a set of points, lines, and/or surfaces, and set of rules used to define the positions of points in space either in two or three dimensions. 

Shapefile: A vector data storage format for storing the location, shape, and attributes of geographic features. A shapefile is stored in a set of related files and contains one feature class. 
Table of Contents: In ArcMap©, the Table of Contents lists all the data frames and layers on the map, and shows what features the symbols in each layer represents.

Working Directory: The directory where all shapefiles created during an SBAS-A are stored.

APPLYING SBAS-A:  
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The SBAS-A application allows users to take advantage of the standard spatial tools inherent in a GIS environment.  Before beginning the development of a Sediment Budget, users should add pertinent datasets into the data frame to assist in the analysis and design of the budget.  Vector, raster and tabular data can all be added using the “Add Data” tool
. 

Many types of data will be used in the creation of a sediment budget and can be easily stored in the GIS environment.  Fluxes into and out of sediment budget cells may be in the form of numerical model output, or of actual data collected during field studies.  The change in volume for cells can be derived from varying types of data and GIS tools.  For example, volume change between successive SHOALS or other bathymetric data sets may be computed directly in the GIS environment.  Volume change may also be derived from comparisons of successive beach profiles or shoreline change data.

Once the initial basemap data has been added into the view, users can begin to use the tools available in SBAS-A.  First, preferences should be set to determine some basic elements of the Sediment Budget.  Selecting the Set Preferences option, from the Alternative Menu can access the dialog box as shown below. 
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Setting SBAS-A default properties.  

The value of the “working directory” is the default location for all layers created through SBAS‑A.   These layers are given the projection system selected in the Projection combination box.  All SBAS-A related calculations use the “measurement units” and “uncertainty method” chosen on this dialog.  Users can also choose the default labeling options.  These preferences can be changed at any point during a SBAS-A session.  Once the “Apply” button is clicked, the changes will take effect.

Creating Cell and Flux Layers

The structure of the sediment budget is now ready to be created.  Using the “Draw Rectangle” and “Draw Polygon” tools located on the Draw Toolbar* of ArcMap, littoral cells can be placed in data frame.  To draw simple, rectangular cells, select the “Draw Rectangle” tool and click where the upper right boundary of the littoral cell should reside; then drag to the lower right boundary.  When the mouse button is released, a rectangle will be displayed in the frame.  To draw irregular shaped cells, select the “Draw Polygon” tool and click to represent each vertices of the polygon.  Double-click to finish drawing the cell.   Once all cells are drawn for the budget, a Sediment Budget layer can be created.  If cells need to be added at a later point, they can be done so with the “Add Graphic to Layer” Tool.

*To turn on the Draw Toolbar in ArcMap, from the Tools menu, select Customize.  Click to check in front of the “Draw” Option.
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Draw Toolbar with Drawing tools highlighted.


Sediment Budget layers can be created from graphics using the “Create Sediment Budget” tool.  To convert a littoral cell graphic into a layer, select “Cell” for the type of layer.  If no alternatives are loaded or no alternatives exist, the dialog will appear as below.  
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Click the “Create New Alternative” button, to name the new alternative.  Each Alternative created, should only consist of one littoral cell and one flux layer.
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Enter in Name and Click OK.
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Select Yes to convert the graphics in the view into a layer.
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Enter name for new layer.  

This layer will be stored in the working directory location set in SBAS-A Preferences. 

All graphics in the view are now converted into a layer in the Table of Contents.  Setting the color and label options can be done by editing the properties of the layer.  To edit these values, right-click on the layer name and select “Properties”.  By default, when a littoral cell layer is created all residual values are set to zero.  Therefore, all the cell colors remain the same until cell or flux values are edited.  Also, the littoral cells have an opaque fill and any data layer beneath the cells cannot be seen.  To change the fill of the layer, transparency can be set.  To change the transparency for a layer in the Table of Contents, first turn on the “Effects” toolbar.  The Effects toolbar can be turned on by selecting the Customize option from the Tools Menu then click to check in front of “Effects”.
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Effects Toolbar. Select littoral cell layer from combination box.
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Flux layers are created in a similar fashion as littoral cells.  To create a flux layer, the “Draw Line” tool is used          .  To connect two cells with a flux, using the “Draw Line” tool, click on the sink cell first and drag to the source cell.  Double-click to end the line.  Flux arrows can also be drawn as polylines. Polylines allow a line to have multiple vertices to “curve” around structures.  When all flux lines are drawn for the Sediment Budget, convert them to a layer using the same steps outlined above for converting littoral cells.  However, the flux option needs to be selected in order to convert the layer properly.  
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Creating a new Flux layer within an existing alternative.

To add the flux lines to the current alternative, select the alternative name from the combination box on the “Create Sediment Budget” dialog; then select the “Create New Layer” button to convert the graphic lines and name the flux layer.  Once the layer is added into the Table of Contents, the lines are transformed into arrows denoting sink and source values. 

Changing the Direction of the Flux

The direction of an arrow can be changed at any time by first starting an Edit Session (from the Editor Toolbar, select Edit, Start Editing), then highlight the flux layer in the Table of Contents, and selecting a flux arrow, and clicking “Change Direction of Flux Arrow” tool. 

Note: The Flip Flux tool will remain disabled until an Edit Session is started.  Once the session is started, the user will be able to change the direction of the flux polylines.


Editing Cell and Flux Values

The selected layer in the Table of Contents and the feature selection of this layer determine the values to be edited when the SBAS-A “Edit Tool” is selected.  From the SBAS-A toolbar, select the Edit Tool, and then select a feature (cell or flux) to edit.  Be sure to select the same feature, as the type highlighted in the Table of Contents.

If a cell layer is selected in the Table of Contents and has a littoral cell selection the following datasheet will display when the “Edit Tool” is clicked:
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Data entry sheet for entering littoral cell values. Click Apply to save value changes.  When values are entered into this spreadsheet and the Apply button is clicked, the residual value is posted in the layer’s attribute table in the Residual field.  

If a flux layer is selected in the Table of Contents and has a flux arrow selection, the following tabbed form will display when the “Edit Tool” is clicked: 
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Data entry forms for editing flux values. Click Apply to save value changes.  When values are entered and the Apply button is clicked, the value per flux is posted in the layer’s attribute table in the Qvalue field.


Data frame once graphics have been converted into a spatial layer and transparency has been set for the littoral cell layer.

Editing Feature Layer

When editing the Sediment Budget, additional cells and fluxes may need to be added to the schematic.  To add these items to an existing layer, either draw graphic polygons (for littoral cells) or polylines (for flux arrows) with the drawing toolset.  Select the graphics, using the SHIFT key to select more than one graphic.  Then, using the “Add Graphics to Layer” tool, select the type of graphic and then the target layer.
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Once the button is selected, the graphics will be added to the target layer.

The design process of the Sediment Budget may also require reshaping existing littoral cells.  If a user needs to resize or move a littoral cell, that already has been converted into a layer, the “Editor” toolbar must be visible and an Edit Session must be started.  To begin an Edit Session, select the “Editor” menu for the “Editor” toolbar and choose “Start Editing”.  Below is a sample of the dialog that appears.  Select your working directory from the list and click OK.
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From the “Editor” toolbar, change the Task to “Extend/Trim Features” and set you target layer to the layer in need of reshaping.  Once these settings are in place, use the “Edit” tool from the “Editor” toolbar to move or resize the dimensions of the target layer.  To save changes to the layer, select the “Stop Editing” option from the “Editor” menu.  When prompted, select “Yes” to save the changes.
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Editor Toolbar with the Edit Tool highlighted.

To completely remove a selected flux or cell from a Sediment Budget layer, select the layer in the Table of Contents and click the “Delete Selected Features” tool from the SBAS-A toolbar. 

Creating a Macro Budget

Now that the Sediment Budget has been represented by littoral cells and fluxes, a macro budget can be created to represent this budget on a large scale.  Using the drawing tools, draw a polygon around the Sediment Budget area to be included in the macro budget. 
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When the “Macro Budget”        tool is selected, from the SBAS-A Budget Menu, the above dialog appears.  Select the layer that contains the littoral cells used in the macro budget.  When the button is click, a new layer is created in the Table of Contents.
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The Collapsed Cell Properties datasheet represents a summary of the macro budget.  This datasheet can be accessed by selecting a macro budget layer in the Table of Contents that contains a macro budget cell selection; then selecting the “Edit Tool”      .  

Saving SBAS-A Alternative

Saving Sediment Budget in the ArcMap© environment requires three steps.  

1. Create cell and flux layers to represent the Sediment Budget with the “Convert Graphics to New Layer” tool.  

2. Save the ArcMap© project, *.mxd, file and Alternative by selecting Save Project/Alternative from the SBAS-A Alternative Menu:
3. Save the Alternative.  The Alternative file (*.sbd) holds all values for the sediment budget. 
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Use drop-down menu to select which Alternative to save, and click the “Save SBAS Alternative” button.
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Browse to location and type in name for the SBAS-A Alternative file and click OK.

The Sediment Budget is now complete.  To access this Sediment Budget during another instance of ArcMap©, the user must load particular files in order to see all values correctly.  First, the saved ArcMap© project file (*.mxd) must be opened.  Once opened, all sediment budget littoral cell and flux arrows should be visible.  Before a user can view or edit cell or flux values, it is imperative that the associated SBAS-A Alternative file is loaded.  To load the Alternative file, select the “Load Project Alternative” button from the SBAS-A toolbar.  
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Next, browse to location of existing SBAS-A Alternative file that is associated with the Sediment Budget layers.  Click OK to Load the Alternative.  If the user is does not remember the associated file name, the file path and name are tagged in the layer’s attribute table in the SBAS_File field.
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Portion of a layer’s attribute displaying Alternative information in the SBAS_File field.

The user is now ready to begin editing an existing Sediment Budget in the SBAS-A environment.  It is vital to continue to save the ArcMap© project file, and SBAS-A Alternative after each session.

EXCHANGING FILES BETWEEN SBAS-A AND SBAS-STANDALONE: 

SBAS-A has been designed for users that have access to existing geospatial datasets that assist them in building Sediment Budgets.  Some of these datasets can include georeferenced aerial photography, beach profile surveys, shoreline position data, dredging history, coastal process, bathymetry surveys, etc. Provided these datasets are in a formats that ArcMap© can translate (*.tif, *.sid, *.shp, *.lyr, etc.), all pertinent information can be added to the data frame for analysis.  Users can view the data spatially in the data frame or view its attributes in its associated database file.  

SBAS-A has been created exclusively for use in ESRI’s ArcMap© environment of ArcView 8©.   It is integrated directly into the ArcGIS© Desktop via a customized toolbar.  Users of SBAS-A are encouraged to take advantage of the basic spatial tools inherent in the GIS environment.

Users who have the basic need for creating a sediment budget, but do not have access to ArcMap© or a variety of geospatial datasets, can use the standalone version of SBAS to create budgets.  If at any point a user upgrades to the ArcGIS©/ArcMap platform, Alternatives in the SBAS-standalone can be exported as ArcMap© ready shapefiles.  Whenever the user saves an SBAS file (.sbs), the (.sbd) file is automatically saved using the same file name.  Once in ArcMap©, users can add the shapefiles as layers in the Table of Contents (using the “Add Data” tool) and load the Alternative, *. sbd file (using the Alternative Tool from the SBAS-A toolbar).  
 

Sediment Budgets created with SBAS-A can also be displayed in SBAS-standalone.  Sediment Budget layers (fluxes and littoral cells) created in SBAS-A can be imported in SBAS-standalone with the “Load ESRI Shapefile” tool.    Also, whenever the user loads an *.sbs file, SBAS automatically loads the corresponding *.sbd file. The saved Alternative (*.sbd file) must also be loaded into SBAS-standalone before cell and flux values can be viewed or edited for the imported shapefile layers.
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In SBAS-Standalone, Alternatives can be exported as a shapefile.

ADDITIONAL INFORMATION:  This note was produced under the Coastal Research Program work unit “Regional-Scale Modeling Sediment Transport and Morphology Change” by Rose Dopsovic, Lynn Hardegree, Julie Rosati, and Jennifer Wozencraft. Ms. Julie D. Rosati at the U.S. Army Engineer Research and Development Center, Coastal and Hydraulics Laboratory is the work unit Principal Investigator.  Questions can be addressed to Ms. Dopsovic at Rose.Dopsovic@sam.usace.army.mil or to Ms. Rosati at Julie.D.Rosati@erdc.usace.army.mil.  This CHETN should be cited as follows:  



 (2002). “SBAS-A: SBAS for ArcView Application.” ERDC/CHL CHETN-IV-__, U.S. Army Engineer Research and Development Center, Vicksburg, MS.

 

(http://chl.wes.army.mil/library/publications/cetn).
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To check the path of the Working Directory, use the SBAS-A Preferences tool.





Summary of all littoral cells encased in this macro budget cell.





These Macro Budget cells can be linked to other macro budgets by drawing flux arrows between the cells.





Use this tool to set level of transparency.





Graphics drawn with Rectangle and Polygon tool.
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